Chapter 462

Conditional Power of One-Sample T-Tests for Superiority by a Margin

Introduction

In sequential designs, one or more intermediate analyses of the emerging data are conducted to evaluate whether the experiment should be continued. This may be done to conserve resources or to allow a data monitoring board to evaluate safety and efficacy when subjects are entered in a staggered fashion over a long period of time. Conditional power (a frequentist concept) is the probability that the final result will be significant, given the data obtained up to the time of the interim look. Predictive power (a Bayesian concept) is the result of averaging the conditional power over the posterior distribution of effect size. Both of these methods fall under the heading of stochastic curtailment techniques. Further reading about the theory of these methods can be found in Jennison and Turnbull (2000), Chow and Chang (2007), Chang (2008), Proschan et.al (2006), and Dmitrienko et.al (2005).

This program module computes conditional and predicted power for the case when a one-sample $t$-test is used to test whether the mean of a population is greater than or less than a specific superiority bound.

Technical Details

All details and assumptions usually made when using a one-sample superiority by a margin $t$-test continue to be in force here.

Conditional Power

The power of an experiment indicates whether a study is likely to result in useful results, given the sample size. Low power means that the study is futile: little chance of statistical significance even though the alternative hypothesis is true. A study that is futile should not be started. However, futility may be determined only after the study has started. When this happens, the study is curtailed.

The futility of a study that is underway can be determined by calculating its conditional power: the probability of statistical significance at the completion of the study given the data obtained so far.

It is important to note that conditional power at the beginning of the study before any data are collected is equal to the unconditional power. So, conditional power will be high even if early results are negative. Hence, conditional power will seldom result in study curtailment very early in the study.
From Jennison and Turnbull (2000) pages 205 to 208, the general upper one-sided conditional power at stage \( k \) for rejecting a null hypothesis about a parameter \( \theta \) at the end of the study, given the observed test statistic, \( Z_k \), is computed as

\[
P_{uk}(\theta) = \Phi \left( \frac{Z_k \sqrt{I_k} - z_{1-\alpha} \sqrt{\hat{I}_K} + \theta(I_K - I_k)}{\sqrt{I_K - I_k}} \right),
\]

and the general lower one-sided conditional power at stage \( k \) is computed as

\[
P_{lk}(\theta) = \Phi \left( \frac{-Z_k \sqrt{I_k} - z_{1-\alpha} \sqrt{\hat{I}_K} - \theta(I_K - I_k)}{\sqrt{I_K - I_k}} \right),
\]

where

- \( \theta \) = the parameter being tested by the hypothesis
- \( k \) = an interim stage at which the conditional power is computed (\( k = 1, \ldots, K - 1 \))
- \( K \) = the stage at which the study is terminated and the final test computed
- \( Z_k \) = the test statistic calculated from the observed data that has been collected up to stage \( k \)
- \( I_k \) = the information level at stage \( k \)
- \( I_K \) = the information level at the end of the study
- \( z_{1-\alpha} \) = the standard normal value for the test with a type I error rate of \( \alpha \).

If we define \( \mu_R \) as the population reference, standard, or baseline mean, \( SM \) as the superiority margin, and \( \mu_1 \) as the actual mean under the alternative hypothesis, then the parameter \( \theta \) to test the one-sided superiority by a margin alternative hypotheses of \( H_1: \mu > \mu_0 \) (higher means better with \( \mu_0 = \mu_R + |SM| \)) or \( H_1: \mu < \mu_0 \) (higher means worse with \( \mu_0 = \mu_R - |SM| \)) and other conditional power calculation components as outlined in Chang (2008) page 69 are

- \( \theta = \mu_1 - \mu_0 \) (the expected difference under the alternative hypothesis)
- \( Z_k = (\bar{x}_k - \mu_0) \sqrt{\hat{I}_k} \) (the \( t \)-statistic computed from the observed data)
- \( I_k = \frac{n_k}{\sigma^2} \) (the interim information level)
- \( I_K = \frac{N}{\sigma^2} \) (the final information level)

where

- \( \bar{x}_k \) is the sample mean, estimating \( \mu_1 \) at stage \( k \)
- \( \hat{I}_k \) is the estimated information from the sample at stage \( k \)
- \( n_k \) is the sample size at stage \( k \)
- \( N \) is the total sample size
- \( \sigma^2 \) is the variance of \( X \) (estimated by the sample variance).
Computing conditional power requires you to set $\sigma^2$, $\mu_0$, and $\mu_1$. Their values can come from the values used during the planning of the study, from similar studies, or from estimates made from the data that has emerged.

### Futility Index
The *futility index* is $1 - P_k(\theta)|H_1$. The study may be stopped if this index is above 0.8 or 0.9 (that is, if conditional power falls below 0.2 or 0.1).

### Predictive Power
*Predictive power* (a Bayesian concept) is the result of averaging the conditional power over the posterior distribution of effect size. From Jennison and Turnbull (2000) pages 210 to 213, the general upper one-sided predictive power at stage $k$ is given by

$$P_{uk} = \Phi \left( \frac{Z_k \sqrt{I_k} - z_{1-\alpha} \sqrt{I_k}}{\sqrt{I_k} - I_k} \right),$$

and the general lower one-sided predictive power at stage $k$ is given by

$$P_{lk} = \Phi \left( \frac{-Z_k \sqrt{I_k} - z_{1-\alpha} \sqrt{I_k}}{\sqrt{I_k} - I_k} \right),$$

with all terms defined as in the equations for conditional power.

### Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

### Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

### Test
**Higher Means Are**
Use this option to specify the direction of the superiority by a margin test.
If Higher Means are “Better”, the alternative hypothesis is $H_1: \mu > \mu_0$.
If Higher Means are “Worse”, the alternative hypothesis is $H_1: \mu < \mu_0$. 
Conditional Power of One-Sample T-Tests for Superiority by a Margin

**Alpha**

**Alpha**
This option specifies one or more values for the probability of a type-I error at the end of the study. A type-I error occurs when a true null hypothesis is rejected.

Values must be between zero and one. Historically, the value of 0.05 has been used for two-sided tests and 0.025 for one-sided tests.

You may enter a range of values such as 0.01, 0.05, 0.10 or 0.01 to 0.10 by 0.01.

**Sample Size**

**N (Target Sample Size)**
This option specifies one or more values of the target sample size, the total number of subjects planned for the study. This value must be an integer greater than one. Note that you may enter a list of values using the syntax 50,100,150,200,250 or 50 to 250 by 50.

**nk (Sample Size to Look k)**
Enter the sample size obtained through look k. If this value is greater than N, the value of N is increased to this amount.

**Effect Size – Means**

**μ₀ (Superiority Mean)**
This is the bound of the superiority by a margin test hypothesis.

If SM is the superiority margin and μ₀ is the reference, standard, or baseline mean, then when Higher Means are “Better”, the alternative hypothesis is H₁: μ > μ₀, with μ₀ = μ₀ + |SM| and μ₀ < μ₁. When Higher Means are “Worse”, the alternative hypothesis is H₁: μ < μ₀, with μ₀ = μ₀ - |SM| and μ₀ > μ₁.

**μ₁ (Actual Mean to Detect)**
This is the actual mean at which conditional power is calculated. Care should be taken that this value is consistent with the alternative hypothesis.

When Higher Means are “Better”, μ₁ > μ₀. When Higher Means are “Worse”, μ₁ < μ₀.

**Effect Size – Standard Deviation**

**σ (Standard Deviation)**
Enter a value for σ, the standard deviation. The source of the value you enter is controversial. Some think you should enter the value used in planning the study. Others think you should use the value estimated from the data obtained so far. Still others think you should use a confidence limit for σ created from the current sample.

You can enter a range of values such as 1 2 3 or 1 to 5 by 1.

Press the σ button to the right to load the Standard Deviation Estimator window.

**Effect Size – Current Test Statistic**

**Zk (Current Test Statistic)**
Enter the value of the t-statistic calculated from the data obtained through stage k. This value may be positive or negative. Usually, the t-statistic ranges between -5 and 5.
Example 1 – Computing Conditional Power

Suppose a study has been planned and is to be analyzed using a one-sided superiority by a margin $t$-test at an alpha of 0.025. The reference mean is known to be 6 and the test will have a superiority margin of 1. The test will have a lower bound of $\mu_0 = \mu_R + SM = 6 + 1 = 7$. The sample size is 50. The standard deviation is expected to be about 1.8. An interim analysis is run after half the data have been collected. This analysis yields a $t$-test value of 2.12. The data monitoring board would like to have the conditional power calculated for actual mean values of 7, 7.5, 8, and 8.5.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Conditional Power of One-Sample T-Tests for Superiority by a Margin procedure window by expanding Means, then One Mean, then clicking on Conditional Power, and then clicking on Conditional Power of One-Sample T-Tests for Superiority by a Margin. You may make the appropriate entries as listed below or open Example 1 by going to the File menu and choosing Open Example Template.

Option

<table>
<thead>
<tr>
<th>Design Tab</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alternative Hypothesis</td>
<td>$H_1: \mu &gt; \mu_0$ (One-Sided)</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>N (Target Sample Size)</td>
<td>50</td>
</tr>
<tr>
<td>nk (Sample Size at Look k)</td>
<td>25</td>
</tr>
<tr>
<td>$\mu_0$ (Null or Baseline Mean)</td>
<td>0</td>
</tr>
<tr>
<td>$\mu_1$ (Actual Mean to Detect)</td>
<td>0 0.5 1.5</td>
</tr>
<tr>
<td>$\sigma$ (Standard Deviation)</td>
<td>1.8</td>
</tr>
<tr>
<td>Zk (Current Test Statistic)</td>
<td>2.12</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Cond. Power</th>
<th>Pred. Power</th>
<th>N</th>
<th>nk</th>
<th>Super. Mean</th>
<th>Actual Mean</th>
<th>Diff</th>
<th>Std Dev</th>
<th>Test Statistic</th>
<th>Alpha</th>
<th>Futility</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.25726</td>
<td>0.85040</td>
<td>50</td>
<td>25</td>
<td>7.00</td>
<td>7.00</td>
<td>0.00</td>
<td>1.8</td>
<td>2.12</td>
<td>0.025</td>
<td>0.74274</td>
</tr>
<tr>
<td>0.76946</td>
<td>0.85040</td>
<td>50</td>
<td>25</td>
<td>7.00</td>
<td>7.50</td>
<td>0.50</td>
<td>1.8</td>
<td>2.12</td>
<td>0.025</td>
<td>0.23054</td>
</tr>
<tr>
<td>0.98325</td>
<td>0.85040</td>
<td>50</td>
<td>25</td>
<td>7.00</td>
<td>8.00</td>
<td>1.00</td>
<td>1.8</td>
<td>2.12</td>
<td>0.025</td>
<td>0.01675</td>
</tr>
<tr>
<td>0.99978</td>
<td>0.85040</td>
<td>50</td>
<td>25</td>
<td>7.00</td>
<td>8.50</td>
<td>1.50</td>
<td>1.8</td>
<td>2.12</td>
<td>0.025</td>
<td>0.00022</td>
</tr>
</tbody>
</table>
Report Definitions

Conditional Power is the probability of rejecting a false null hypothesis at the end of the study given the data that have emerged so far.

Predictive Power is the result of averaging the conditional power over the posterior distribution of the effect size.

N is the anticipated total sample size.

nk is the sample size obtained through stage k.

μ0 is the superiority mean used to construct the hypotheses.

μ1 is the actual mean to detect under the alternative hypothesis at which conditional power is calculated.

δ1 = μ1 - μ0 is the mean difference that is to be detected by the completed study.

σ is the standard deviation of the response.

Zk is the value of the test statistic from the observed data at stage k.

Alpha is the probability of rejecting a true null hypothesis.

Futility is one minus the conditional power. A value greater than 0.9 or 0.8 indicates the study should be stopped because there is little chance of achieving statistical significance.

Summary Statements

The first 25 of the planned 50 subjects achieve 25.726% conditional power to detect a difference of δ1 = μ1 - μ0 = 0.00 using a non-inferiority t-test with a bound of μ0 = 5.00, an actual mean of μ1 = 5.00, a standard deviation of 1.80, and a significance level of 0.025. The t-value of the data that have emerged so far is 2.120. The futility index is 0.74274.

This report shows the values of each of the parameters, one scenario per row. The definitions of each column are given in the Report Definitions section.

Plots Section

This plot shows the relationship between conditional power and μ1.
Example 2 – Validation

We could not find an example of a conditional power calculation for a one-sample superiority by a margin $t$-test in the literature. Since the calculations are relatively simple, we will validate the calculation of the third scenario of Example 1 by hand.

In this case

$$I_k = n_k / \sigma^2 \quad I_K = N / \sigma^2$$

$$= \frac{25}{1.8^2} \quad = \frac{50}{1.8^2}$$

$$= 7.7160494 \quad = 15.432099$$

$$P_{uk}(\theta) = \Phi \left( \frac{Z_k \sqrt{I_k} - Z_{1-\alpha} \sqrt{I_K} + \theta(I_K - I_k)}{\sqrt{I_K - I_k}} \right)$$

$$= \Phi \left( \frac{2.12 \sqrt{7.7160494} - 1.959964 \sqrt{15.432099} + (8 - 7)(15.432099 - 7.7160494)}{\sqrt{15.432099 - 7.7160494}} \right)$$

$$= \Phi \left( \frac{5.905473}{2.777777} \right)$$

$$= \Phi(2.125970)$$

$$= 0.983247$$

This value matches the third line of the report in Example 1.